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Hello, this is Eric Bobrow, and in this lesson we'll continue on from the previous one as we focus on
some more of my favorite techniques for drawing and editing in the 3D window. We'll look at the
concept of gravity, which places elements at a height based on other elements that are already drawn.
3D guidelines, which are a new feature in ArchiCAD 15 that allow you to snap directly in the 3D window.
The use of temporary elements for snapping as well as real elements to create complex shapes such as
roofs that follow an arbitrary slope. And also these can be used for aligning 3D textures such as the
starting point of bricks or blocks. [0:00:47]

Now I've been drawing some things, just placing them at an arbitrary height, and then moving them
around. But can you set your height where you need it to before you putitin? So let's just go and I'll
take an AXO view now, I've been in perspective. Let me take an AXO view. And let's say that | wanted
to putin aslab. I'll go in and put in a slab right now that would be, in this case, not a ceiling but a floor.
So we'll put this on the floor. And perhaps I'll just draw a box and snap it right underneath the walls
here. And now this particular slab I'm going to go and extend. I'll use the option to extend it. Let's just
imagine that we had a little balcony space here. And I'll take his element and we'll take this perhaps as a
patio. [0:01:47]

So now these are two different heights, and I'm going to draw some walls on one height or another. So
I'll use the Wall tool and | will turn on the Gravitate to Slab. When | do that, if | draw the wall let's say
and click here, you can see the wall is precisely at the right height. Now of course, it's facing the wrong
way, so | would want to switch this over here or do that while I'm doing it. So let's just say if I'm in the
middle of placing it in here and | notice that this is the wrong side | can switch the geometry there and
get that to work. [0:02:24]

But | can also go over here and you'll notice how the wall is automatically going there because | have the
gravity turned on. You can see this turns it on or off, and this is the choice of what you are gravitating
to. Now if | were to do a wall, if | wanted to create some type of a chimney or dormer or something like
that, sometimes you may want to do it on the roof. So I'll go and let me make just a shorter piece here,
and I'll click. And it's doing this. Now what happened there? It didn't find the roof, it went, if we look
around, it's probably buried inside the building here. Let me just select all walls. [0:03:13]
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Actually in fact, that wall that | just drew was put over here, so totally surprising place. If | go back to
our previous view here, you can imagine that this was done. I'll just undo it and redo it and you'll see its
handles. So when | undo and redo, you'll get handles on something. Of course | can then delete it. But |
want to get this wall on top of the roof, so | will switch my gravity to the roof. And then if | click and
place it, you can see how it's naturally falling in there. Now the gravity, if | go in the other direction, let's
say to get along the Y axis either using the Shift key or the guideline that shows up in ArchiCAD 15, it's
noticing that part of the wall is sticking into the roof. And do | want to trim it? So yes, I'll say maybe |
want to trim the base. And you can see what's happening here. [0:04:12]

Now this wall is now permanently or semi- permanently trimmed to the roof. And it didn't really
actually keep its relationship to the other wall or its height. | guess I'm not sure what height - | think the
other wall was set up maybe at the back edge here. I'm not quite sure. But let's just undo this and we'll
do it with a continuous shape. I'll do a poly wall here and go back up, and you can see that now these
are working because the gravity point was used for both of them. Now if | go the other direction, let's
say along here, it's going to find the height of the roof at that upper point. And now if | use the Shift key
and snap it here and do the other two walls, you can see how these two walls are based at the height of
the roof at this point. [0:05:13]

If | rotate it around, you will see that this is floating in space. So it will take it at whatever point you start
on. In other words, the first click point determines that elevation. So obviously we can move the these
things down, | can select these two walls here and use the option to move them down, snap it into
position here, and then either use the crop or trim to clean the bottom up. Or whatever | need to do in
terms of construction for that. Now the gravitate to the roof is automatic if you're doing something like
a skylight. So if we use the skylight element, let me just pick a simple one here. And when | do that, if
there is a roof underneath it, it will automatically find the roof and find the slope. [0:06:03]

And it actually also cuts a hole in it. Let me just switch - the roof has a hole here, and I'm wondering
why we're not seeing through this. Well maybe we are seeing through it, and it's- in fact there is a hole
there. If | were to go - let's pop this in an area where we can see. Actually, let's just cut a hole in with
the Marquee tool or take a view here through this and then look at that. Then we'll see that it's
automatically cut the hole. So the skylight tool automatically gravitates to the roof. In fact, if have the
Skylight tool active, the gravity icon becomes gray, because it does look for the roof, and can't gravitate
to anything else. But when I'm in other tools, then the gravity can be turned on or off and it can choose
whether I'm looking at a roof or a slab or other things like the shell or mesh. [0:07:10]

Now I'm not going to demonstrate a shell in today's lesson, but | will show you a mesh. Very simple,
because this is a very important part. And I've demonstrated some similar things in a lesson on site
modeling. But just a quick review. If | have a mesh, and | will just do a simple site. And perhaps take
this point up to 10 feet, and this one to 4, and this one to 6, things like that. Now if | go to 3D, we're
going to see - and let's just say Show All in 3D, we're going to see that the building is now a little bit
buried in that terrain because of what | did. But the point | want to make is that if I'm putting certain
elements like trees on here, | can go in and let's just find library part for tree, and pick one of these nice
trees that we've got. That looks like a nice one. [0:08:15]
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Let's just say that | use the tree and | gravitate to the mesh and make sure that that's turned on and
then just put it in simply. | will just click here; the tree will be low down. | will click here and it will be
higher or at whatever height it needs to be. So if | select these elements - actually I'll just look from the
side here - you can see that they're at different heights. This tree here is at zero and this one is at 4 feet
and this one is at 8'8". So basically they all found their height based on where | was clicking on the Mesh
tool. [0:09:03]

Now in addition to gravity, we can use other tools to set up relationships and snap to elements that |
haven't demonstrated. Let's actually take this mesh and we're going to hide it right now. So | can
simplify things. And let's just say that | wanted to draw, and | will do this in 2D. Again just to
demonstrate some of the flexibility. If | wanted to work in 3D and line things up, in ArchiCAD 15 we do
have 3D guidelines. So let's take a look. If | were to go to the Wall tool and say that | wanted to take this
wall and line it up with the edge of this other wall, as | move along this edge you can see the orange dot.
And if | click on that orange dot now | have a guideline. And | can snap to that guideline. So that is similar
to what we would do in the floor plan but it's available in 3D. [0:10:03]

Now let's say that we wanted the height of this wall to actually be the same as where this roof would
extend. In other words, if this roof were to extend - and let me just get rid of this tree here since we
don't need this anymore - if this roof were to extend what height would the wall need to be? Now this
is a rather arbitrary situation right now, but I'm sure you can imagine sometimes when you want to
position something at the virtual projection of another element. So what I'm going to do is I'm going to
go and - actually I will go to the edge of this roof and click on the orange dot. And you can see how it
draws a guideline in space along that edge as well as its projection on the plan. And if | move around,
you can see how it's maintaining that just whatever angle I'm in. [0:10:52]

So now | can easily go and select this wall, tell it to change its height and bring it up until it snaps. And |
can move in here until you can see it very clearly on screen. It's snapping; it allows me to snap to that.
Let's take this up here and we can just snap it right to that point. So if | select this roof and | were to
extend it here to this point, you can see how they are precisely at the same height. So in other words, |
brought up the wall exactly to where the roof would extend using that guideline for the roof. So that's a
couple of examples of using the guidelines in 3D in ArchiCAD 15. [0:11:39]

Now when we are drawing things at these different heights for the gravity, we can also get some clarity
using the View menu and the 3D View Mode, turning on the Editing Plane Display. So when | do that,
you can see that right now the Editing Plane, which is that sort of light blue area, is right at the zero level
because the wall is set to be at zero. If | were to tell the wall that | wanted it to be up at 10 feet, then
the Editing Plane would go up to indicate that - if | were to draw a wall just right now, let's just sort of
draw this in space, that this is actually up at the ten foot level. You can see how it gave me some visual
clue as to what was going on. I'll just undo the wall there. [0:12:34]

Now if | were to go where | have the gravity set for the slab, then if | click up in this area, you can see
how the Editing Plane has moved and is indicating visually. And even if | were to orbit, you can see how
it's showing me what I'm working on. On the other hand, if | use the gravitate and I'm on this lower
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level, then the Editing Plane again has adjusted to show me a little bit better with feedback here what's
going on in terms of the plane that I'm working on. So if you set the height of the wall manually to a
certain height, it will float up there. [0:13:19]

Now right now | had set it up to 10 feet and the Editing Plane has changed. But for some reason it's still
showing the zero. Maybe if | turn off the gravity. Anyway, this feedback looks like it's not staying totally
up to date because the Editing Plane is still showing up at that 10 foot level. But the Editing Plane will
also show up if we were to edit let's say the roof. When | select this roof and say that | want to project
it, make it longer, you can see how the Editing Plane adjusts to show me - | will get a better picture of
what I'm doing. And certainly it can be useful just to get a sense of what is happening here. [0:14:04]

Now sometimes you may want to project something in relationship to another element that is down
below, but not make it a straight up and down or be projected down. | don't have a really good example
of this, but let me just go and draw another wall. Let's just say at the zero foot level just a short little
piece. And I'll just draw this wall straight here. Now suppose | wanted to make this roof extent not
directly above that wall, but | would like to make it extend to where it would be perpendicular. In other
words, where we could do that. [0:14:45]

So again, not a great example, but let's just take this. | will go and select this roof here and go to the
edge and tell it | want to project it. If | normally snap this here, you will see that thisisin line. It's
actually straight above that other wall. But let me just undo that and let me go start this process. And
now | can go to the View menu and | can go to the 3D View Mode, Editing Plane and say that | would like
to go, let's say Projection Editing Plane, Perpendicular to Editing Plane. So what this does - and this is
just one example of an unusual thing that could be very powerful in the right context. | will say
perpendicular to the plane that I'm using for editing, and now you can see that this relationship - and I'll
just sort of orbit around a little bit - is projecting it perpendicular. So this overhang, if | were to create a
piece going from this corner to the corner of the wall, it would be perpendicular to the roof. So there
are going to be some times when that type of control is going to be useful. And you can change that
right on the fly for the current editing operation. [0:16:12]

Now I'm going to show you an opportunity to create a roof in 3D directly with small elements. Now the
simple case that we have, let me just do something with the Wall tool on the plan to do this. Let's say
that | go and create a basic shape here. If | go to 3D - and let me take this wall. I'm going to undo them
and then redo them, and that will actually quickly select them. That's a nice little trick there. And let me
just make them up at 10 and | will use the eyedropper so the next ones would be there too. So now if |
go to 3D, if | wanted to make the roof on top of them - just like the slab. If | go to the Slab tool and | use
the Magic Wand, | can Magic Wand this and it will put the slab right underneath it. [0:17:17]

If on the other hand | use the Roof tool and | say | want to do a complex roof, now in ArchiCAD 15 this
would be a single roof system. In ArchiCAD 10 through 14 it would be a series of individual planes but it
would be very similar. | can go Magic Wand this and you can see how it's traced this, although the
height of these roofs was set incorrectly. Let me just set the height up at the 10 foot level here and

4 Best Practices Course — Week 15 Part 6 — © copyright 2012 by Eric Bobrow



perhaps change the slope to something lower, and then use the Magic Wand and trace this. And you can
see how that now automatically fit the roofs to the walls. [0:18:00]

So that's one way that we can create groups right in 3D based on geometry, walls that are have already
been drawn for the building. There is another way that is certainly much less frequently used but is very
powerful and flexible that I'm about to show you. Let me just draw a box of walls here and I'm going to
go and show just these walls in 3D. And let's say that we wanted to have a roof that's sloped up in a
combination, two directions at once. If | take this wall here and perhaps raise it up to 15 feet from its
original 10 and this back wall again do the same thing and take it up to 18 feet. What I'm doing here -
and I'll just zoom out a little bit - is I'm setting up so that | can draw a roof that would touch this lowest
corner point here, touch the next corner up here, and go up to the highest point there. [0:19:10]

So these are three points that are going to define a plane. What | care about is that the roof actually fits
on those points. And when it covers the rest of the building, it will just have whatever shape is an
extension of that plane. This is just one option that | would like to show you. So I'm going to go to the
Roof tool. And when we're in the Roof tool and we're drawing the roof in this method, we are going to
be using the single plane method in ArchiCAD 15 and the choice of a polygon or a rectangle creation. In
ArchiCAD 10 through 14, we would just have this one method here, the polygon, which allows you to
create any arbitrary shape. [0:19:55]

And we're not going to use the Magic Wand, because | want to specify the heights individually based on
the points I'm looking at. So I'm going to orbit just a little bit to get more of a top down view and then
pan here. So by the way orbiting again, press the center mouse button down and the Shift key allows
me to orbit, and when | let go of the Shift key then I've got the Hand or the Pan tool. I'm going to go
click on this point, and ArchiCAD will determine that this is not only pointing the X, Y, it's also a point
with a certain height. | will click on this corner here. And again this has an X, Y, and Z height. And you'll
notice as | go up towards the third point that it's drawing a plane in space. [0:20:38]

And when | click, that determines the plane; three points will always determine a plane. At this point it's
a little confusing because | don't see anything drawn. And it shows in a prompt box, "Enter first node of
roof polygon." So what that means is that | can draw perhaps the same points, but it doesn't have to be
the same points, because in fact | can go to any other points that | wish, and it will be whatever that
plane is. And so | will do a very simple case just of the four points that match the wall boundaries, three
of which | used to define the plane. [0:21:10]

Now you can see that the walls are - there are gaps here, but the roof is following that general shape
that | had. Now to make this work in terms of closing up the gaps, I'm going to go and select all the walls
and use the Solid Element Operations. Now I've tried using the trim elements to roof shell under the
Connect menu and there were some issues. In this case it didn't work so well. Let's try Solid Element
Operations. In order to be able to do this, | will need to take the walls up higher. So what I'll do is go
and take any of the walls, go to the option in the pet palette to change its height, and perhaps just type
in something high enough that it's going to go above all of the roofs, all of the walls here. [0:21:59]
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Actually that didn't quite work. Let's take this up here, and you can see actually that's interesting.
When | did this and all the walls were different heights, it maintained the difference between them. In
other words, this one wall being the middle height, the one in the back being the highest. I've never
actually played around with this changing the height of multiple walls that were different. Of course if |
were to type in a value, something like 20 feet, then they would all go to exactly the same height. But
when we stretch it, apparently it's keeping the offsets, at least in this version of ArchiCAD. But no
matter, | just need to make sure that they are high enough to go above the roof line, and then | can go
make them the target here and go select the roof and make it the operator. [0:22:49]

And I'll use the Subtraction with Upward Extrusion and Execute it, and you can see how beautifully that
works. And as | spin around you can see what it's done. Now let me go back to the floor plan and we'll
see that there is a roof drawn here and the roof has a pivot line that is on an odd angle. Now ArchiCAD
calculated that pivot line based on its own calculations of the plane. It's interesting that it took the
second point as the basis of the pivot line. That second point was at 15 feet. So it basically said, alright
we will set the pivot line at the second point and we'll figure out what angle in space and has to be to
make sure these other two points are at the right heights. So it does some calculations there that allow
you to get the plane that you want. [0:23:38]

Now let's draw a similar plane, and let's do something that would be more of a folded plane. So thisis a
slightly more complex situation. And | will demonstrate something with a different approach in terms of
setting heights. So if | go now and say show the new walls that I've just selected, perhaps what | want to
do this at some heights using instead of the walls | will set using a temporary element. A convenient one
that | found is the Column tool. So | will go to the Column tool and perhaps go and tell it to put a
column in by its lower left corner. So | will zoom in on this here. And perhaps | will select this column
and change its height. [0:24:20]

Let's see, here, sorry change the height up here. I'll just make it a little bit taller than the wall so that it
sticks out. And then perhaps I'll just drag, and I'll drag this up to the other corner. Whoops I lost control
of that for a second. | will just drag this, press down the option or CTRL key to get the plus sign, you can
see the plus sign is attached, and I'll go from his upper corner to the other corner there. And let's say
that | wanted to perhaps change the heights in 3D just as an experiment. So | will go back to the view in
3D. And let's say that | leave this one at 12 feet, but | will take the back one up quite a bit. Maybe | will
take this up 20 feet here. [0:25:14]

Now I'm going to go and create two roofs that will connect to each other like folded planes would be a
common design concept. So I'll say | want this first roof to go up, and | will carefully make that I'm
snapping to the corner of the column this case because that's what | want. And that created the plane.
And | will go over the same three points here, and then I'll just click one more time on the third point,
and that will complete that particular plane. And now | will start in the other direction for the other
plane with these two points of the wall that are horizontal. In other words, they're at the same height.
And | will rotate around right on the fly during this using my orbit. So the center mouse button there.
[0:25:59]
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And | will then click on this corner point here. | can go in either direction. And you can see what that's
done. It looks like | missed on the first one. So let me just undo back these two and just do it one more
time cleanly. So | want to make sure that | get the corner and perhaps zoom on this, get this corner. And
make sure that I'm on the back corner, because that's what | wanted. And then again | will do this, these
three points up here. And | will click one more time to finish that particular piece. And then I'll start the
same thing going in the other direction for this. And remember the third point here is going to
determine the height or the actual plane in space. And then | can start in either direction. [0:26:55]

I'll go back just for convenience to these points here. And again, just after the third point click again, and
you can see now |'ve got a folded plane. So basically two roof pieces that are meeting cleanly. And let's
go and perhaps select all the walls again, and just change their height. or I'll just make sure they are
above this, make them the target. Select both roofs in this case to be the operator and execute the
subtraction with upward extrusion. And so now you can see we've got - and I'll just minimize the Solid
Element Operations here. So you can see now it's meeting cleanly. Now | could get rid of these columns
at any time. So if | just carefully select them here. I'll move around until | can select the columns and
delete them. So they're really just there as a temporary guide. [0:28:00]

Now if we go back to the floor plan we'll see something interesting. The roof plane that was on the left
side was going up an irregular slope. In other words, it was at one height on one corner or a second and
third separate heights, so ArchiCAD figured out the slope. But the roof that was the other piece of the
folded one actually was going horizontally between these two walls points. So its pivot line is much like
a common roof where it's actually flat along the edge of the wall and then going up some arbitrary
angle. Now the angle here we can see it being read off as number of feet in rise over run. But we can
also say what is the degrees? It's 10.9° or percentage, we can read that off if we want. So that's another
way we can work with the Roof tool directly in 3D to create some more complex forms and shapes.
[0:28:57]

Now let's look at one final part of the training lesson today, and that will be how to use the temporary
elements like the column and other convenient points to control the textures. Anyway what I'll do is
draw the marquee now in the back part of this building here and we'll take a 3D view and go around.
Now I've set these two walls to have a block pattern. So obviously, we can have the walls with any type
of pattern. I'll just put it, for example, if we put it to a stone here, well there's no real origin for the
stone. It works fine. But if we were to put it into let's say a concrete masonry unit of a large enough
size, we might want to have it so that it meets properly at the corner. [0:30:00]

Now | had already done some work on this previously, so let me just undo that by going to the Design
menu, Align 3D Texture, Reset. And we will see what this looks like in its original position. So when you
first put it on, it may not look correct at the corners. You can see that we are not getting the whole
brick, it's just not looking quite right. It is matching vertically, the two walls, but let's just see. What if
we wanted to make this wall start - or let's say this one on the left here, which is off, | wanted to make a
start the corner there. [0:30:37]
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So what I'll do is select this wall, go to the Design menu, and say Align 3D Texture, Set Origin. And then |
will click on the corner here. And you can see how all of a sudden, it adjusts. | can do the same thing
with this one and we'll see what it does there. So you can see now it's adjusted. Now it may or may not
be correct. In other words, it's got full blocks next to each other, but we're getting some control that we
can work with. Now I've put in a window here, and the window is sort of at an arbitrary height. Let me
actually emphasize it's arbitraryness by just grabbing and changing its height on the fly to some value.
[0:31:22]

Now let's say that this particular height of the window we wanted to have the blocks coming up right
neatly to it. Instead of putting the window into the wall at the height that would match the box, let's say
that we needed the window to be at a certain height and we wanted the blocks to match. Well what we
can do is select the wall, and go to the Design menu, Align 3D Textures, Set Origin and actually click on
the window. And now you can see how the blocks have aligned to that point. [0:31:53]

So we can align to the corner, we can align to the window. Now of course the other wall didn't actually
coordinate. We can actually use the same window. We can align it to that, and you can see now how it's
working more coherently there. Now sometimes we may just want to use a temporary element. So what
I'm going to do is put a column here. And let's just say that will put it in by its center. And I'll make it a
very short column just for demonstration purposes. Let's just say that we wanted it to be 20 inches, that
would be about 1/2 a meter. And I'll just click here. [0:32:31]

So you can see what that did is it put in a column, the center point is right at the corner of the wall. And
let's say that we wanted these blocks to start or line up here, that maybe the bottom part of the wall
was a different material. So what | can do is select perhaps both of these walls and go again to the
Design, Align 3D Texture, Set Origin, and click on this column point. Now everything lines up to that. And
of course | could get rid of this column if | don't want it. So it's certainly a very convenient thing to use
temporary elements like the column to set snap points for a variety of things such as the height of the
roofs in that three-point method that | showed earlier, as well as to set texture origins. [0:33:19]

Now by the way, if we do want to change the angle, we also have the option under the Align 3D
Textures to say Set Direction. And so it says right now in the prompt, "Click the main surface of the
selected element." So I'm going to click on that. And it says, "Do you want to define the angle graphically
or numerically?" So let's just say that | typed in 45°, we're going to see how rotates here. Let me undo
that, and let's say that | go again do the same command, set direction, and click on the surface and then
do it graphically. And | can say OK, from this point to this point. [0:33:59]

Now | have to have something to snap to for it to work with. So you may, if you needed to have a
particular origin for design purposes, you may want to actually put things like that column that | did as a
snapping point. | believe it has to be on the surface, but it could be a separate element that has a snap
on that surface. Just like the window is a separate element from the wall. But we are able to snap to it.
[0:34:26]

So | think that concludes our lesson on some additional tools for drawing and editing and modeling
directly in 3D. Working with gravity, working with the 3D guidelines in ArchiCAD 15, using the option for
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creating roofs directly in the 3D window, and some of the options for aligning 3D textures when that is

of interest or importance. Please add your comments and questions to the page down below, this has
been Eric Bobrow. Thanks for watching.

[END OF AUDIO 0:35:05]
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